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Class Description
Come and learn how some of Excel’s more advanced features—like conditional formatting, absolute references, PMT, and VLOOKUP functions—make working with large spreadsheets and data sets even easier. 
 
Curriculum Track 
 Microsoft Tools			

Audience
Adults

Course Length
90 minutes

Training Method
Instructor-led hands-on

Purpose
To introduce users to more advanced Excel features

Equipment Requirements
Projector and projection screen; computers with internet access for the instructor and each participant; laser pointer (recommended)

Software Requirements
Windows 7, Microsoft Excel 2010 or 2013
[bookmark: _GoBack]
Material Requirements
Pens or pencils, Budget Practice File, Loan Calculator Practice file, Advanced Market Orders Practice File, Vehicle Order Practice File, Activity Sheets, handouts, participant surveys

Learning Objectives
At the end of the session, learners will be able to: 
· Apply at least one type of conditional formatting to a cell
· Create an Absolute Reference in a formula
· Create multiple worksheets in a workbook and link a formula between them
· Access the Function Library
· Use the PMT function to calculate a loan payment
· Use the VLOOKUP function to find a value in a numeric range

Assessment Technique(s)
Successful completion of class activities
Content Outline
Agenda (2 mins)
· Outline the following topics that will be covered in class
· Conditional Formatting
· Creating an Absolute Reference in formula
· Working with multiple worksheets in a workbook
· Review of formulas/functions & the Function Library
· The PMT function
· The VLOOKUP function

Topics, Talking Points, and Activities (85 mins)
· Conditional Formatting
· Explain that conditional formatting is the function where a user can apply pre-made rules to a cell to make the data stand out through the use of color, data bars or icons
· For example, you may need to keep track of certain values in a spreadsheet. You can use conditional formatting to have a cell appear bold only when the value is between $5 and $10
· On the Orders worksheet inside the Advanced Market Orders Practice file, demonstrate the use of conditional formatting to highlight all the shipping values between 5 and 10 using the following steps:
1. Select cells F2:F74
2. On the Home tab in the Styles group, click on Conditional Formatting
3. Scroll down to Highlight Cell Rules, then click on the Between option in the dialog box
4. In the Between window, type 5 in the first box and 10 in the second box
5. Select Yellow Fill with dark yellow text from the dropdown list
6. Click the OK button
7. Clear the rules by clicking on Conditional Formatting, then Clear rules from Selected Cells
· With cells F2:F74 still selected, briefly demonstrate the other conditional formatting styles available by arrowing over examples from Data bars, Color Scales, and Icon Sets
· Explain that to create a more custom formatting rule, users need to click the New Rule option in the Conditional Formatting dialog box
ACTIVITY: Have participants complete Activity #1 on the Activity Sheet

· Creating an Absolute Reference in a formula
· Explain that an absolute reference is one which constantly refers to a specific cell or range of cells, even if the spreadsheet is edited or the formula is copied/filled into another cell 
· Share that a row is made static by adding a $ before the row and/or column in the formula. For example, $C$3 is an absolute reference to the third column and the third row vs. the relative cell of C3 which could change, if copied. 


· To further illustrate the concept, share this example with participants: If a user has multiple orders and he or she wants to determine the cost for a purchase PLUS a flat rate shipping fee, he or she would create a formula including an absolute reference to the cell containing the shipping fee to determine the total cost of the order  
· On the Orders worksheet in the Market Orders Practice File, first demonstrate what happens if an absolute reference is not used in the following example:
1. In cell H2, type =E2 + G2 and hit the Enter key
2. Point out that the total now reflects the price plus the new shipping fee
3. Using the Fill feature, fill cells H2:H74 
4. Point out that only cell H2 has the correct value. Click on cell H3 to see that the formula has changed. Explain that because the formula did not include an absolute reference to the cell containing the shipping fee, the formula adjusted to fit the pattern
· Now, walk through the same example using an absolute reference to show participants the difference between the two methods
1. In cell H2, change the formula to include the absolute reference: =E2+$G$2 
2. Refill cells H3:H74 to reflect the change and produce the correct total amounts
ACTIVITY: Have participants complete Activity #2 on the Activity Sheet

· Working with multiple worksheets in a workbook
· Discuss how a workbook can be made up of multiple worksheets (usually just called sheets) and the benefits of using multiple sheets
· Discuss how you can create formulas that reference another workbook or sheet. For example, you may have a list of orders that came from various companies and want a separate sheet for each company that tracks their orders, dollars spent, etc. 
· Using the Advanced Market Orders Practice File, demonstrate how to add a new worksheet for one of the companies listed. Follow the steps listed below to add a new worksheet to the workbook and name it: 
1. If a new tab is not already present in the workbook, click on the + to add one
2. After adding a new worksheet (or if one already exists), right-click on the tab and select the Rename option
3. Type Arnold’s into the box and press the Enter key
4. Change the color of the tab.
· Next, create a formula that references the Company Orders worksheet to determine what percentage of the total order amount belongs to Arnold’s 
1. Copy and paste cells A1:C8 from the Company Orders worksheet into Arnold’s worksheet
2. Type Total in cell B9 and calculate the sum in cell C9
3. In cell B10, type Percent of Total Orders
4. In cell C10, start typing the formula needed to calculate the percent: =C9/
5. Click on the Company Orders worksheet, then scroll down to click on cell C75 which contains the total amount of sales. The cell reference will be added to the formula. Because it is in another worksheet, the reference includes the worksheet name: worksheet name!cell reference; Example: =’1st Quarter!E4’
6. Press the Enter key to complete the formula, then format cell C10 as a percentage. You should see that Arnold’s orders made up approximately 7% of the total sales.
7. Demonstrate how to copy a worksheet by right-clicking on the Arnold’s tab and selecting Move or Copy
8. Select Move to End and check the box that says Create a Copy, then click the OK button 
ACTIVITY: Have participants complete Activities #3 & 4 on the Activity Sheet

· Review of formulas/functions & the Function Library
· Quickly review with participants that a formula is an expression that calculates a value. 
· Share that a formula includes the following elements:
· Starts with an = (equal sign)
· Must contain cell addresses
· Must contain operators to perform the calculations (such as :, +, /, or -)
· Share that a function, which can be used in a formula, pre-defines required operations for users. Explain that functions include the following elements:
· Most functions contain at least one an argument that produces a result
· Must contain a specific structure that occurs in a particular order (part 1 = function name followed by a parenthesis, part 2 = arguments inside the parenthesis)
· For example, the SUM function looks like this: SUM(number1,[number2],...) where Number 1 refers to the number in the first cell to be added, Number 2 refers to the second cell to be added, etc. 
· Explain that all functions in Excel are located in the Function Library on the Formula tab 
· Click on each category (AutoSum, Recently Used, Financial, Logical, Text, Date &Time, Lookup & Reference, Math & Trig, and More Functions) to display examples of each

· The PMT Function 
· Explain that the PMT function allows users to calculate the payment for a loan based on constant payments and a constant interest rate. Share that this function is located in the Financial category of the Function Library 
· Outline that the structure of the PMT function is PMT(rate,nper,pv,fv,type)
· rate: The interest rate for the loan per period. Yearly loans can be expressed as Rate%/12. For example 5%/12. (NOTE: This is a required field)
· nper: The total number of payments for the loan. (NOTE: This is a required field)
· pv: The present value, or the total amount that a series of future payments is worth now; also known as the principal (NOTE: This is a required field)
· fv: The future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (zero) [the future value of the loan is 0] 
· type: The number 0 (zero) or 1 and indicates when payments are due. A 0 indicates that the payment is made at the end of the period; a 1 indicates that the payment is made at the beginning of the period
· For example, the companies listed on the Loans tab of your Market Orders Practice File all are owned by the same corporation. Assume that this year they took out a loan to cover some operating expenses. The loan was issued for $3000 to be paid back in two years at an annual interest rate of 2.5%. Using the PMT function, the monthly payment—including interest—can be calculated
· Demonstrate how to use the PMT function using the Loan worksheet in the Advanced Market Orders Practice File as you outline the following steps:
1. Click on cell H14, then click on the Formulas tab
2. Click on the Financial button in the Function Library and select PMT
3. In the rate box, type H9/12 (or select the cell, then type /12)
4. In the nper box, type or select H13
5. In the pv box, type or select H7, then click the OK button
· The calculated value of $128.28 will appear in red in cell H14. Click on the cell to verify that your formula matches this: =PMT(H9/12,H13,H7)
ACTIVITY: Have participants complete Activity #5 on the Activity Sheet

· VLOOKUP
· Explain that the VLOOKUP function is located in the Lookup & Reference option within the Function Library
· Share that this function allows users to search for something in a table or a range by row by looking for a value in the leftmost column of a table and returning a value in the same row as the column specified 
· Share that if when looking up a range, users must be sure their table is in ascending order (1st column)
· Outline that the VLOOKUP function is structured like this: (lookup_value, table_array, col_index_num, [range_lookup])
· Next explain what these elements indicate, as listed below:
· lookup_value: Indicates the value you are searching for
· table_array: The data range used to search for the lookup value. The left-most column will be searched. If the VLOOKUP formula will be copied the reference to the table should be made absolute. 
· col_index_num: The column number of the table array containing the value to be used for the VLOOKUP. the columns are numbered, left to right, starting with 1.
· range_lookup: Determines if you want to find the closest match or an exact match.  For the closest match, type True; for an exact match, type False.
· For example, one could find all sales totals for one company by looking up the order number
· Demonstrate the VLOOKUP function using the Paul’s Beverage worksheet inside the Advanced Market Orders Practice File worksheet as you outline the following steps:
1. Click on cell C3, then click on the Formulas tab 
2. Click on Lookup & Reference in the Function Library and select VLOOKUP
3. In the lookup_value box, type A3 and press the Enter key
4. In the table_array box, click on the spreadsheet icon, then click on the Orders tab. Select cells A1:H74 and click on the spreadsheet icon again
5. Click in the col_index_num box (you should be returned to your original tab) and type 8. This tells Excel that the value you are looking for (Total) will be found in the 8th column from the left. Point out that it has displayed 4.42 as the return value in the VLOOKUP box
6. In the range_lookup box, type FALSE and press the OK button. The value will appear in box C3
7. Click on cell C3 to verify that the formula displayed in the formula bar matches this: =VLOOKUP(A3,ORDERS!$A$1:$H$74,8,TRUE)
8. Click on the Orders tab to verify that $4.42 is the total amount for Paul’s Beverage Order 10943. Return to Paul’s Beverage tab to fill cells C4:C13
ACTIVITY: Have participants complete Activity #6 on the Activity Sheet

Wrap Up/Closing (3 mins)
· Highlight the upcoming technology classes and share the types of topics that will be covered
· Ask if there are questions and answer any that were “parked” during the session
· Thank participants for coming and ask them to complete the class survey before leaving
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